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INTRODUCCION

Los métodos de evaluacion y
clasificacion de la calidad de
granos y semillas son proce-
sos rutinarios encuadrados en
normativas propias de cada
pais, siendo importante que
los mismos conduzcan a una
determinacion rapida, objeti-
va y precisa.

Segtin lo establece el codigo
alimentario argentino; el as-
pecto que permite clasificar
la calidad del grano de arroz
es la morfologia de los mis-
mos, encontrandose arroces
de tipo largo ancho o doble
Carolina; de tipo largo fino;
de tipo mediano y, finalmente
arroces tipo corto o Japonés,
similares a la variedad Yama-
ni.

Dentro de una misma panoja
de arroz puede ocurrir que
muchos granos no “se lle-
nen”, es decir quedan vanos
(Figura 1). Esta valoracion
de calidad; generalmente es
realizada de forma manual,
donde un personal entrenado
emplea un calibre para estos
registros lo cual hace que el
proceso sea complicado y te-
dioso. Afortunadamente, los
avances en los desarrollos de

Figura 1: Panoja con granos de arroz. los de color mas oscuro estan llenos, mientras que los mas
claritos son vanos

caracter tecnologico han per-
mitido mejorar y acelerar es-
tos procesos, incluso dejando
de lado la subjetividad propia
de los mismos.

A continuacién se desarrolla
un tutorial que funciona de
manera sencilla, rapida y de
bajo costo. El mismo consis-
te en el empleo de un escaner
de escritorio como elemento
de registro de imagenes y el
software de libre distribucion
ImageJ® para su procesa-
miento. Cabe destacar que
este procedimiento también
es extensible a otros tipos de
granos y semillas.

RECURSOS NECESARIOS

Los elementos necesarios se
encuentran en la mayoria de
los lugares de trabajo: una

computadora (de escritorio
o notebook) con su sistema
operativo y un escaner de es-
critorio para obtener las ima-
genes. El programa Imagel,
destinado al procesamiento
digital de imagenes (se puede
descargar de https://imagej.
nih.gov/ij/download.html).

Este software se puede cje-
cutar en computadoras que
cuenten con sistema opera-
tivo Windows, Linux o Mac
OS X

ACERCA DE LAS IMA-
GENES DIGITALES

Existen diferentes formatos
de imagenes, pero en gene-
ral, una imagen digital es una
matriz rectangular formada
por celdas. Cada una de es-
tas celdas recibe el nombre

Figura 2: Diferentes resoluciones de imagen A (100 dpi), B (200 dpi), C (300 dpi)
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de pixel. Cada pixel puede
almacenar un valor entre 0
y 255, valor que se relacio-
na con la intensidad. Cada
imagen color se compone de
3 capas correspondientes a
los colores rojo, verde y azul
(RGB por sus siglas en in-
glés). Existen otros espacios,
pero en este articulo nos ocu-
paremos solamente del espa-
cio RGB.

Un parametro importante que
se relaciona con la calidad
de las imagenes es su reso-
lucion, valor que se expresa
en dpi (dot per inch o pixeles
por pulgada). Generalmente
es un valor que oscila entre
100 y 600 dpi. A mayor re-
solucion, mejor la calidad de
la informacion que los algo-
ritmos pueden obtener de una
imagen. Pero, por otro lado,
también se genera un archi-
vo de mayor tamafio y como
consecuencia, una mayor
demora empleada por estos
algoritmos para procesarlos.
Una resoluciéon de 200 o 300
dpi resulta mas que adecuada
para el tipo de tarea que nos
proponemos realizar. La Fi-
gura 2 presenta una imagen
de un grano de arroz con di-
ferentes resoluciones.

OBTENIENDO LA IMAGEN

Para obtener la imagen de los
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granos de una muestra a pro-
cesar, se los coloca sobre la
bandeja del escaner cuidando
de que no estén en contacto
entre si, similar a lo presenta-
do en la Figura 3

Es importante conocer la re-
solucién a la que se registra
la imagen. Este valor figu-
ra en la interfase de usuario
de configuracion del escéner
que aparece antes de adquirir
la imagen. En el ejemplo de
la Figura 3, las imagenes es-
tan escaneadas con una reso-
lucion de 300 dpi.

Otro factor a destacar es la
eleccion de un adecuado co-
lor de fondo al adquirir la
imagen. En el caso de gra-
nos de arroz, el azul real es
el color més adecuado para
que los algoritmos permitan
“separar” los pixeles que for-
man parte del fondo y los que
forman parte de los granos.
Se coloca entonces en la con-
tratapa del escéner, un trozo
de goma EVA del tamafio A4.
Para otros granos, es impor-
tante disponer de diferentes
colores para hacer las prue-
bas de contraste.

Finalmente hay que tener en
cuenta la pérdida de infor-
macion que suelen tener los
archivos de imagen que usan
algun tipo de compresion
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Figura 3: Imagen de una muestra de granos
de arroz

como el formato JPG. Como
en este caso, no vamos a eva-
luar texturas (importante para
detectar defectos), podemos
almacenar en este formato
en lugar del formato BMP
que almacena sin pérdida de
informacion, pero a expensas
de ocupar un mayor espacio
en disco.

TRABAJANDO CON
IMAGEJ

No vamos a hacer un desarro-
llo de todas las funciones de
procesamiento de imagenes
que tiene el programa. Solo
nos centraremos en aquellas
que son de nuestro interés, es
decir en las que se refieren a la
identificacion de los granos en
una imagen y en la determina-
cion de sus dimensiones.
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- Separacion en canales.

Una vez cargada la imagen en
Imagel, procedemos a sepa-
rarla en los canales RGB que
la componen. Esto se realiza
seleccionando del ment Ima-
ge -> Color -> Split Channels

Se obtienen tres imagenes
correspondientes a cada ca-
nal como muestra la Figura 4

De los tres canales que se
visualizan en la Figura 4, el
mejor contraste se aprecia en
el canal rojo (A). Este canal,
se usard para binarizar em-
pleando el histograma de di-
cho canal.

- Histograma y binarizacion.

Cuando hablamos de pro-
cesar imagenes digitales, es
usual trabajar sobre el his-
tograma de la imagen. Un
histograma es un grafico de
barras en el que el eje X re-
presenta el valor del pixel (0
-255)y el eje Y es el nime-
ro total de pixeles que tiene
cada uno de esos valores en
la imagen. Por ejemplo, el ca-
nal rojo de la Figura 3 tiene
el histograma que se presenta
en la Figura 5.

En este histograma el pico
de la derecha corresponde a
pixeles de los granos de la
imagen, mientras que el pico
de la izquierda corresponde a
los pixeles del fondo.

Con el histograma se rea-
liza la binarizacion. La bi-
narizacién es un algoritmo
que consiste en hacer que
un pixel pueda tomar sola-
mente dos valores posibles:
si este corresponde al fon-
do toma valor 0 y si corres-
ponde al grano toma valor
255. Para ello se selecciona
un valor de intensidad co-
nocido como valor umbral
de intensidad. Usando el

Figura 4: imagenes de los tres canales RGB: A (rojo), B (verde), C (azul).

histograma, este valor se
encuentra entre los dos pi-
cos.

La binarizacién se puede rea-
lizar de dos formas; a) Con la
funcion “Binary” y b) Con la
funcién “Threshold”

a) Funcién “Binary”: Esta
funcién permite determinar
automaticamente el umbral
de binarizacion. Es ttil en
el caso que las imdagenes
tengan un buen contraste.
Con la imagen seleccionada,
se accede a la funcién con
Ment -> Process -> Binary
-> Make Binary. Una porcion
de la imagen binarizada del
canal rojo de la Figura 3 se
presenta en la Figura 6.

b) Funcion “Threshold”: per-
mite binarizar la imagen se-
leccionando manualmente el
umbral de binarizacion. Esta
forma es util cuando no se lo-
gra un buen contraste o cuan-
do la funcion Binary no logra
resultados satisfactorios. Se
accede a la funcion con Menu
-> Image -> Adjust ->Thres-
hold. Aparece una ventana
de configuracién como la

de la Figura 7. La seleccion
del umbral manualmente da
como resultado la imagen del
canal rojo binarizada (Figura
8).

Como se puede observar, el
resultado de la binarizacion
de ambas funciones, para este
tipo el grano de arroz con el
fondo azul real, es la misma.

ESCALA

Conocer la resolucion de la
imagen adquirida, nos va a
permitir realizar las determi-
naciones de las dimensiones
de los granos. Una resolu-
cion de 300 dpi implica que
son 300 puntos en 25.4 mm
(equivalente de una pulga-
da). La configuracion de
escala se realiza: Menu ->
Analyze -> Set Scale. Si la
resolucion es de 300 dpi la
ventana de configuracion
quedaria con los siguientes
valores (Figura 9).

La opcion “Global” se tilda
cuando se va a usar la misma
escala (o imagenes de la mis-
ma resolucion) durante toda
la sesion de trabajo.
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Figura 5: histograma del canal rojo
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Figura 6: Imagen binarizada del canal rojo.
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ELIPSE QUE MEJOR
AJUSTA

La determinacion de la elip-
se que mejor ajusta para cada
grano permite conocer las di-
mensiones (largo y ancho) de
estos. Este método consiste
en sustituir el area proyecta-
da del grano de arroz, por una
elipse que cumple las mismas
propiedades geométricas que
la del area proyectada del
grano.

Imagel permite, a través de
este algoritmo y para cada
grano de la imagen, deter-
minar la longitud de los ejes
mayor y menor de la elipse,
que se corresponden con la
longitud y ancho de los gra-
nos (enteros o partidos).

En esta ventana, tenemos di-
ferentes opciones acerca de
las medidas que se pueden
realizar sobre los objetos que
se detectan en una imagen bi-
narizada. Solo dejamos tilda-
da la de la elipse que mejor
ajusta.

Con la imagen binarizada
seleccionada  procedemos
al conteo de granos con sus
dimensiones con la opcion
Analyze Particles. Vamos a
Mentu -> Analyze -> Analy-
ze Particles, presentandose
una ventana de configuracion
como la de la Figura 11.

CONTEO DE GRANOS Y
DIMENSIONES

Indicamos primero que infor-
macion queremos obtener con
la opcion Set Measurement.
Para eso vamos al Menu ->
Analyze ->Set Measurements
y nos abrird una ventana como
la de la Figura 10.

La opciéon “Size (mm”"2)”
permite excluir del conteo ob-
jetos no deseados (particulas
pequenas de suciedad) de la
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Figura 7. Ventana de configuracion de la

funcién Threshold.

imagen. Configuramos el va-
lor inicial en “1” para que to-
dos los objetos cuya area pro-
yectada sea menor de 1 mm?
queden excluidos del analisis.

PRESENTACION DE RE-
SULTADOS

La Figura 12 presenta los re-
sultados del largo y ancho del
total de granos de la Figura 2.
La primera columna presen-
ta el nimero de grano, en la
segunda, la longitud del eje
mayor de la elipse que me-
jor ajusta que se correspon-
de con el largo del grano. La
tercera columna representa
la longitud del eje menor de
la elipse que se corresponde
con el ancho del grano y la
cuarta columna la orientacion
del grano en la imagen.

Estos resultados se pueden
exportar para Ser procesa-
dos con programas externos
como una planilla de céalculo.
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Figura 9: Ventana de configuracion de la
escala
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Figura 8: Imagen del canal rojo binarizada con
la funcién Threshold

El grado de precision entre
la elipse que mejor ajusta y
el grano de arroz, se puede
observar en la Figura 13 en
la que se presentan, para una
porciéon de la Figura 2, di-
ferentes elipses ajustadas al
contorno del area proyectada
de los granos.

RECOMENDACIONES

Antes de comenzar a usar de
manera rutinaria, es impor-
tante “ensayar” con configu-
raciones cuyos resultados se
conozcan de antemano. Por
ejemplo, se podrian tomar la
imagen de 20 granos, medir-
los con un calibre, y contras-
tarlos con los obtenidos por
PDI. Conociendo el nimero
total de granos, también po-
demos validar el conteo he-
cho por PDI.
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Figura 10: Ventana de configuracion de
medidas
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Estos procedimientos apli-
cados, se pueden acelerar
usando macros. Las macros
son secuencias de coman-
dos que se ejecutan una a
continuacion de otra hasta
la ultima instruccion. Es
decir, la separacion en ca-
nales, la seleccion del ca-
nal rojo, la binarizacion, la
configuracion de la escala,
el conteo de los granos con
sus dimensiones, y la pre-
sentacion de los resultados,
se pueden programar en una
sola macro para actuar so-
bre una imagen. Luego para
otras imagenes del mismo
grano obtenido de la misma
manera, simplemente ejecu-
tamos la macro para obtener
los resultados. De hecho se
podrian aplicar sobre lotes
de imagenes, siempre que
los nombres de las mismas
se puedan encuadrar dentro
de una variable con algin
valor numérico. Por ejemplo
los archivos de diferentes
muestras se pueden guardar
con el nombre “FotoXX”
para que en la macro, XX se
tome como una variable que
cambie desde 1 hasta el to-
tal de imagenes a procesar,
logrando hacer los calculos
sobre un conjunto de archi-
vos con una sola macro.

CONSIDERACIONES
FINALES

Las dimensiones de granos y
semillas se pueden medir con
precision empleando un es-
caner de escritorio e ImageJ.
Tiene las siguientes ventajas:

- Los tiempos de medicion
se reducen notablemente en
comparacion al empleo de un
calibre, sobre todo para gran-
des muestras de granos.

- Si se definen macros, no se
requiere de personal entrena-
do para un proceso de medi-
cion que suele ser rutinario.
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Figura 11: Ventana de configuracién de
Analyze Particles.

- Es econdmica ya que se rea-
liza con hardware presentes
en cualquier lugar de trabajo
y con software gratuito.

- La unica demora que tiene
se relaciona con la ubica-
cién de los granos en la ban-
deja del escaner, sobre todo
al colocar de modo que los
granos no estén en contacto
entre si.

- La seleccion del color de
fondo para cada grano, reso-
lucidn, valores de umbraliza-
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Figura 12: Resultados generados

cidn, etc, se realizan una sola
vez.

En los casos en que la bi-
narizacion sea compleja de
realizar, s¢ puede emplear
un escaner con adaptador de
transparencias ya que tienen
la ventaja de poder relevar
la imagen retroiluminada
de los granos obteniéndose
casi una imagen binarizada.
La desventaja es que la su-
perficie de escanco es mas
pequeiia que una hoja A4
dificultando el manejo de
una muestra numerosa de
granos.

i Result of 1.1 IRGA MNTbmp ired)-... — O =
175.26x220.98 mm (207 0x2610); 32-hit (inverting LUT); 21MB
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Figura 13: Elipse que mejor ajusta al area proyectada del grano.



